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This document is intended to help users find, download, and use free

Landsat data for almost any land surface in the world using a freeware

software program, MultiSpec 
©
.

GETTING THE FREE SOFTWARE  (p.2) | GETTING THE FREE DATA  (p.3) |

USING COMPRESSION SOFTWARE  (p.15) | PREPARING THE THERMAL BAND (p.16)

| LINKING BANDS OF DATA  (p.20) |

 SUBSETTING IMAGES FOR SMALLER FILE SIZE  (p.24) | HELPFUL TIPS  (p.31)

General Note: When following the steps in this tutorial, it may help

you to read all the notes about each step before taking it.

Introduction

Many professional and educational programs use satellite data and

images to study our changing Earth. In particular, the Landsat

Program has provided over 30 years of calibrated high spatial

resolution data of the Earth’s surface to a broad and varied user

community, including agribusiness, global change researchers,
academia, state and local governments, commercial users, military,

and the international community. This uninterrupted record provides

abundant opportunity for “before and after” comparisons of Earth’s

land surface throughout the past 30 years. To read more about
Landsat data and its uses please visit http://landsat.gsfc.nasa.gov or

http://landsat.usgs.gov.

For details about the data and use of the data please examine the
Landsat Data Users Handbook at

http://landsat.gsfc.NASA.gov/IAS/handbook/handbook_toc.html.

This tutorial provides instruction on how to obtain and import free

Landsat data into a free software program, make subsets of the data,
and create images that can be used to examine change over time.

The data used in this tutorial are from the Global Land Cover Facility

(GLCF) at the University of Maryland’s Institute for Advanced
Computer Studies in College Park, MD. The two data sets (one from

circa 1990, and one from circa 2000) cover the entire globe except
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Antarctica. Together these data sets constitute the ”Landsat Geocover

Data Set.”

The free software used in this tutorial is Multispec©, developed at

Purdue University, West Lafayette, IN, by David Landgrebe and Larry

Biehl from the School of Electrical Computer Engineering, Agronomy

and Laboratory for Applications of Remote Sensing.

Getting the Free Software
TOP

It is recommended that users take the MultiSpec© tutorial before
using the software.  The tutorial is available through the GLOBE

program at:

http://www.globe.unh.edu/Training/New_Training.html

Software Step 1: Go to

http://dynamo.ecn.purdue.edu/~biehl/MultiSpec©/ and download

MultiSpec©.  Make sure to download the correct version for your

computer.   There are versions for Macintosh and Windows software.
MultiSpec© is updated regularly with additional features.  Users who

want to conduct more advanced operations may want to visit the site

and upgrade their software twice a year.
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Getting the Free Data
TOP

About the Data: Landsat observations of the Earth’s surface are
divided into “scenes,” each of which is approximately 185 km by 172

km. A grid system of “paths” and “rows” is used to provide a reference

number for each scene. The satellite is in a circumpolar orbit that

provides repeat coverage of the same area every 16 days. The data
used in this tutorial are orthorectified. Orthorectified scenes are

georeferenced, meaning that if one lays a scene from one locality

directly on top of another scene from that same locality, all of the map

locations will match up exactly. This makes Orthorectified Landsat
scenes especially useful for detecting change over time.  More

information about change detection is available from NASA’s Landsat

Change Detection subset pair web site. [URL to this will be provided

here prior to  publication.]

Data Step 1: Go to the Global Land Cover Facility’s web site at:

http://glcf.umiacs.umd.edu/index.shtml

The Global Land Cover Facility (GLCF) provides Earth science data and

products free to anyone via FTP. The GLCF provides other datasets in

addition to the one used in this tutorial. The Landsat GeoCover data

set is the subject of this tutorial.

Data Step 2: At the Global Land Cover Facility’s Web site, select

the Earth Science Data Interface by clicking on the map within

the Download Data option (at right of screen).



4

Data Step 3: Select the Map Search option.
You can also use the Map Search to browse and query using an

interactive map. You must use the Map Search when looking for

Landsat GeoCover data.  The Map Search will provide two

geoferenced scenes for anywhere in the United States from around
1990 and 2000.  These scenes are excellent for change detection.

Data Step 4: Select all three instruments from the Landsat

Imagery box (Ignore the other options.)
“ETM+”, “TM”, and “MSS” refer to different sensors that have flown on

different Landsat satellites through the years.  The GeoCover 1990

data is Landsat TM data and the GeoCover 2000 data is Landsat ETM+.

Data from other years may be available for your chosen geographic
location, so select all three instruments.

Select the

Landsat
data
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Data Step 5: Select the “Place” tab.

When looking for data, the place function is the easiest to use.

Select the
Place Tab
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Data Step 6: Enter the major place name nearest your area of

interest.

At the bottom of the new window is a blank box labeled “Place.”  In

this box enter a major place (city, for example.)

Available Place Names

The database currently contains the following place names that can

be searched:

• All countries.
• Worldwide states, provinces, and equivalent country

administrative units (i.e., Oblasts).

• Major world cities.

• United States cities with population greater than 10,000 (circa

1998).

Note: For more information regarding the place name search refer

to the “searching tips” available at the Earth Science Data Interface

(ESDI) at the Global Land Cover Facility. Or, click the link directly
above where the place name is entered.

http://glcf.umiacs.umd.edu/esdi2help/place.html#availPlaceNames

Enter Place
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Data Step 7: Select Update Map (just below the map).

Data Step 8: Once a place name has been indicated, select the
Preview & Download button (just below the map).

When the selection area is displayed, a red square (or a few squares)

will appear on the map, representing the extent of the Landsat
scene(s) you have selected.  If your desired location is not in the area

covered by the red square(s), go back and select using “map area”

instead of “place.”

Note: The Preview & Download option will not work if no scene has

been selected.

Select

Preview and
Download
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Data Step 9: Select the Preview & Download option from the

selection map.

In the Preview & Download results window, seen below, there are

numerous features.  All of the scenes of the user’s selected location

available from the GLCF are listed.  Yellowish highlight indicates a

selected scene. A thumbnail of that selected scene appears at the
upper left side of the screen.  (The thumbnail is a false color composite

image (usually a 4,3,2 band combination, which means that vegetation

is shown as red.) Additionally, this screen includes a reference map

indicating the spatial extent covered by the scene.  (The reference
map is especially helpful when there are multiple scenes in the list.)
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Data Step 10: Choose a Landsat scene (data) from the list.

If there are more than two scenes in the list, the best scenes to select

are the ETM+ (Landsat 7) scenes. ETM+ scenes if they are available

will result in higher quality images, though a user may wish to choose
data based upon date, depending upon need. To select another scene

in the list, select its [ID] number or the “Next” button.  A preview

image and a table will be displayed at the top of the Web page.

In the Attribute column, “Ortho, GeoCover“ refers to orthorectified, a

process that corrects and improves the geographic coordinates

associated with the scenes.

Data Step 11: Re-sort the list of scenes if desired.

Use the lists [Acq. Date] function to re-sort the list.  Click it once to

sort the data with the oldest scene/data at top and click again to
reverse the order, with the oldest scene/data at bottom.

List of images

available at GLCF

Reference Map for
selected image
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Data Step 12: Choose the desired scene (for example, the most
recent) from the list.

Click on the identification [ID] number to select the scene.

Data Step 13: Open the download page for the selected scene.

Note: In the example below, the downloadable file is 171 MB.

The download rate will depend greatly on the type of Internet

connection being used.  Downloading is a one-time process, and
can be done anywhere with access to a high speed Internet

connection.

Additionally, Landsat scenes are separated into individual files,
so each one is not very large.  The process may take some time,

but should be manageable.

Click the Download button.

Data Step 14: Understanding the file name protocol

At the top of the page you will see the file name for your selected
scene; below this you will find a list of file names. The file names

follow a protocol, and contain important information.

The GLCF scene file-naming protocol may appear a bit complex to a

novice user. In our example, the file names begin with

p015r33_5t879516. So what is in the Landsat data file name?

p015
Landsat 7 orbits the Earth in a preplanned ground track. The sensor

onboard the spacecraft obtains data along the ground track at a fixed

width or swath. When mapped, the swaths are called “paths.” The

Download the image
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concept of path is somewhat analogous to longitude.  Thus, p015

stands for Path 15. Our scene example shows Washington, D.C.  Path

14 is to the east, and path 16 is to the west, of Washington D.C.

r33 means Row 33, which signifies how far down from the North Pole

the scene was acquired.  There are no negative rows or paths.

5t870516  tells us that the scene is from Landsat 5, and the date is

shortened from 1987, May 16th to 870516.

Note: Our example uses Landsat 5 TM data files (signified by

the 5t in the file name p015r33_5t870516).  Landsat 7 data files
have a L7 in the front of the file name (L71015033), and

Landsat 1-4 MSS data have a 1 to a 4 with an m after it

(p016r33_1m1972).

Note that all the files begin with the path/row and date.  The

remaining portion of the file names vary as follows:

browse.jpg is a jpeg color composite image.

hdr is header file, and it is not always included.

met stands for  metadata. It is a very important file, especially if you

plan to use the scene in GIS applications. It includes all of the Landsat
scene information specific to how and when this scene was acquired.

Additionally, all the processing and geographic information is included

in the met file.

preview.jpg is a smaller version of the browse.jpg image.

The remaining file names represent the Landsat data itself.  They are

listed in numerical order, and the number represents the band. For

example, nn10tif.gz signifies band 1, nn20.tif.gz signifies band 2
and so on. Table 1, “Landsat Data Characterizations for the Various

Missions,” indicates the bands of data used by the various Landsat

satellites.  Notice that the numbers and wavelengths have changed

over time, with different Landsat satellites. Landsat 7 has nine bands
of data; Landsat 1-3 have only four bands of data.

Data Step 15: Download and uncompress the selected scene

files.
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Click on each link and download only one file at a time. Download all

the files and place them in a folder. (It is important that they all be

placed in the same folder.) The data is a compressed TIFF file. The gz
at the end as in, nn7.tif.gz, means that the file is compressed.

Some files may not automatically download, but may open in your

browser or other image viewing software (such as Preview).  In those
cases, you must manually save them to your folder.  To manually

download and save the files with a Windows program, right-click the

file name and select “Download the Link to Disk” or “Save Target As.”

With a Mac, hold down the Control key, “ctrl”, and click on the file.
Then select the “Download the Link to Disk.”

(This image is from Mac OS X.)

Your computer may give you a message stating that you cannot save a

“.tar” file without “.jpg” at the end.  That is OK; go ahead and allow

“.jpg” to be added to the file name.

After each manual file save, use the “Back” button to return to the list

of files to be downloaded.

Hint: It may help you to keep track of which files you have

successfully downloaded if you copy the list from the Web site

and paste it into a Word document.  You can mark each file

downloaded as you proceed through the list.
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Once the files are downloaded, most computers will automatically

uncompress the files.  If they do not do so, double click the file.  The

compression software should open and ask you to uncompress the
files.

What if the computer does not open the files?

In this case, your computer does not have compression software.
(Most computers do have this software.) Use the steps below, under

“Using Compression Software,” to download the software, and then

extract or uncompress the files.

To help with file management, it is recommended that the user create

a new folder for all the data. In educational settings, the Landsat TM

band 6 or Landsat ETM+ bands of data 61, 62 or 80, are not typically

used, so most teachers or students would not need to download them.
These file names end with either B80.L1G.gz for band 8 or B62.L1G.gz

for band 62.  Also note that Landsat MSS data has only four bands of

data (no blue data, but green, visible red and two infrared bands).

More information about the files is available in Table 1 below.

Example of typical set of downloaded Landsat files:

File Name Download Size Actual Size
p015r33_5t870516.browse.jpg 77564 bytes  

p015r33_5t870516.hdr 2635 bytes  

p015r33_5t870516.met 361 bytes  

p015r33_5t870516.preview.jpg 8645 bytes  
p015r33_5t870516.tar.jpg 77564 bytes  

p015r33_5t870516_nn1.tif.gz 25946026 bytes 61625338 bytes

p015r33_5t870516_nn2.tif.gz 22784521 bytes 61625338 bytes

p015r33_5t870516_nn3.tif.gz 26405598 bytes 61625338 bytes

p015r33_5t870516_nn4.tif.gz 31810459 bytes 61625338 bytes
p015r33_5t870516_nn5.tif.gz 32862658 bytes 61625338 bytes

p015r33_5t870516_nn6.tif.gz 12444511 bytes 61625338 bytes

p015r33_5t870516_nn7.tif.gz 27801311 bytes 61625338 bytes
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Table 1: Data Characterizations for Various Landsat Missions

Landsat 1-3 Landsat 4-5 Landsat 7

Sensor MSS - MultiSpec©tral
Scanner

MSS - MultiSpec©tral
Scanner &
TM - Thematic
Mapper

ETM - Enhanced
Thematic Mapper

Mission
coverage dates

August 7, 1972 to
February 7, 1983

August 17, 1982 to
October 1999

July 1999 to
present

MultiSpec©tral
Bands                  (band 1-4)                          (band 1-5,7)                     (band 1-5,7)

Resolution 80 m 30 m 30 m

Band  (microns) 0.5-0.6
0.6-0.7
0.7-0.8
0.8-1.1

.45-.52

.52-.60

.63-.69

.76-.90
1.55-1.75
2.08-2.35

0.45-0.52
0.52-0.60
0.63-0.69
0.76-0.90
1.55-1.75
2.08-2.35

Thermal Band                                                 (band 6)                          (band 61 & 62)

Resolution N/A 120 m 60 m

Band (microns) N/A 10.4-12.5  (Landsat 5
only)

10.4-12.5

Panchromatic Band                                                                               (band 8)

Resolution N/A N/A 15 m

Band (microns) N/A N/A 0.5-0.9
(Panchromatic)
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Using Compression Software
TOP

Windows Users:

Compression Step 1: Open the folder on your computer where the
images are downloaded.

Compression Step 2: Highlight all the files and right-click.

Compression Step 3: Select the “Extract files” option and follow

the steps.

Note: Users who do not have the “Extract files” option will need to
download compression software.  It is available from Winzip, at:

www.PCSHAREWARE.com/download/download_unzipwiz32.htm

Download the Unzip Wizard, which is needed to unzip the Landsat

data.  Make sure to download the correct version for your computer.
Or

If you do not have the compression software, go to Aladdin

Systems, Inc. StuffIt Expander for Macintosh or StuffIt Expander

for Windows
http://www.stuffit.com/mac/expander/download.html

StuffIt Expander easily expands, decodes, and unzips the data.

Make sure to download the correct version for your computer.

Mac Users:

Compression Step 1: Open the folder where the images are

downloaded.

Compression Step 2: Highlight all the files, hold down the control

keyand mouse click.  This will open the menu shown below (for OS X

platform).

Compression Step 3: Select the “Open With” option and select
“Stuffit Expander.”
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Compression Step 4: The uncompressed files will be opened into

the same folder.

Note: Compression software is available from Aladdin Systems,

Inc. StuffIt Expander for Macintosh or StuffIt Expander for Windows

http://www.stuffit.com/mac/expander/download.html

StuffIt Expander easily expands and decodes all the Landsat files

you downloaded from the Web.  Make sure to download the correct
version for your computer.

Preparing the Thermal Band
TOP

If you plan on using all the Landsat bands of data, you will

need to modify band 6 (thermal data) to work with the 30-

meter band data.

As noted in Table MLI 1, all Landsat missions had different spatial

resolutions for the thermal band data and the multispectral data.  The

Landsat 7 MultiSpectral data have a resolution of 30 meters, whereas

the Thermal data have a resolution of 60 meters. Study the images
below to see the spatial resolution differences between the two

Landsat bands.

In MultiSpec©, if the 30 meter and 60 meter data are linked without
modifying the 60 meter thermal data, the software will automatically

degrade the other bands of 30 meter data resolution to 60 meter

resolution. Instead, you can use MultiSpec© to increase the thermal

band area and file size to match the other bands, thus preserving the
30-meter resolution of the data.
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Part of Washington D.C. where bridges cross the Potomac

River, in Near Infrared Band 4 (30 meter resolution, upper) and

Thermal Band 6 (60 meter resolution, lower)

Note: Currently the preparation of the thermal data can be done
only in MultiSpec© Mac versions (as of April 1, 2005). The same

preparation can be done on other platforms using image or photo

software such PhotoShop, by doubling the image size for both lines

and columns.

Steps to preparing Thermal band data:

Thermal Step 1: Open MultiSpec©.  Open the Thermal band 6 (TM)
or 61 (ETM+) band data file. Go to File>Open Image, then select the

thermal band data (example of file name on GLCF:

p015r33_5t870516_nn6.tif.gz).

A box that asks for specifications will appear. Click “OK”.

Click “OK” for the next screen as well. The computer will now

compute image statistics and ask you to save this new file.
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You must change the name of the file from the default, or the

program will write this file over your original data file. Simply change

the name of the file and save it to your data folder. Now an image in
grey scale will appear

Thermal Step 2:  Under the “Processor” menu select “Reformat,” and
then the “Rectify Image” option.

Thermal Step  3:  The “Set Image Rectification Parameters” window

will open.  Change the “Rectification Settings” Scale to 2 for both the
Lines and Columns windows.  Click “OK”.

Note: this step will take quite some time to complete if you are

doing this for a full scene.

Thermal Step 4:  Save the Image in the same folder as the other

satellite images.  Remember to save the image with both the date and

the band number.  See the example in the image below:
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Thermal Step 5:  Compare the new image file to the other data files,
and make sure that the new one is the same file size and also covers

the same area (that is, be sure the path and row are the same for

each file).

Before the scaling (Thermal Step 4)

After the scaling

Now the Thermal band is ready to be linked with the other

bands.
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Linking Bands of Data
(Combining Landsat bands into one image file)

TOP

Linking Step 1:  Open MultiSpec©.  Under “File” go to “Open

Image.” Locate your downloaded image files (see Data Step

12), and highlight the blue band (band 1) image file.

(For a description of the file names see Data Step 14:

Understanding the file name protocol, above.)

Note:  If the image file names do not appear when you open the

folder, select the “All Files” option in the “Files of Type” pull

down menu.

Linking Step 2: Click on “open.” A box that asks for

specifications will appear. Click “OK.”
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Click “OK” for the next screen as well. The computer will now
compute image statistics and ask you to save this new file.

You must change the name of the file from the default, or the

program will write this file over your original data file. Simply change
the name of the file and save it to your data folder. Now an image in

grey scale will appear.

Linking Step 3:  Go back to “File” and again click on “Open Image”.

Highlight …B20.tif file name, and before you click OK, click the box

beside “Link to active image window”.  Then click “open”.

Linking Step 4: Continue this process until you have opened and
linked all the data files.  Link them in numerical order starting with the

lowest number (B10, B20, B30, B40, B50, B61, B70).  Once all of the
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files you need have been opened, click “Cancel”. Open and link only

the Landsat data files (example of data file name:

L71015033_03320020618_B10.tif), Avoid linking the other kinds
of files, as it will confuse the software.

Note:  At the top of the image (see example above), the file name

should read, “L7…“ This signifies that you have linked seven bands

together.  Make sure that the number of files you intended to link is
the same as the file name shows.

Note:  If the images open in separate windows, the images were

opened without the “Link to active image window” box being
selected. Close the windows and restart the linking process from

Linking Step 1.

Note: if you want to work with the entire Landsat scene, save the

image with all the linked bands using the reformat function in
MultiSpec©. (Pull down the Processor menu, select Reformat, then

Image File Format).
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Now you are ready to subset the scene.
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Subsetting
TOP

Many users of Landsat data find that they do not need the entire scene
for analysis. Teachers often find that large spatial areas, especially an

entire scene, will overwhelm students and their computers. If you

want to subset an area from a large Landsat image, follow these steps.

Subsetting Single Images

The data files must be linked prior to following the subsetting

instructions! See section above “Linking Bands of Data.”

Subsetting: Single Image Step 1: Select the area on the image to

be subsetted.  A recommended area would not be larger than 2000

pixels by 2000.  In MultiSpec© you can see how large the selection
area is by using the coordinate view.  Pull down the “Window” menu

and select the “Show Coordinate View” option.

This will show the Coordinates of the image at the top.  On the top left

there is a pull down menu showing the MultiSpec© default Coordinate

View of Lines-Columns.
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Using the Coordinate View you can select an area to subset.  The

“Number pixels” function gives you a good clue about how many pixels

have been selected.  To select an area, place your cursor at the upper

left corner of the area you wish to select, click the mouse and drag

down to the lower right.  The coordinates will change, and the number
of pixels in the selected area will be calculated.  For a 2000 by 2000

pixel area there are 4,000,000 pixels.  Teachers note: If the “number

pixels” is higher than 4,000,000 it may be too large of an area to work

with for students.

Subsetting: Single Image Step 2: Pull down the “Processor” menu,

and select “Reformat.”  A box will appear; select “Change Image File

Format.”

Subsetting: Single Image Step 3: In the “Image File Format

Change Options” window, find the “Header” pull down menu, and

select the GeoTIFF format.  (This option will only work if the Landsat

data is originally a GeoTIFF.  The GeoTIFF file format is ideal because
the file header contains all of the geographic information.)
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Subsetting: Single Image Step 4: Click “OK”.  When the next box

pops up, don’t change the start and end lines and columns, but make

sure the intervals are set at one.

Subsetting: Single Image Step 5: Click “OK.”  The next box to pop

up is for you to name and save the multi-channeled image.  Give the
image a name such as “name of county” and the date the image was

acquired.   End the file name with the file extension “.tif”  An example

would be “Seattle_06_23_01.tif”  Make sure you are saving the

image to the same file where you have all the previous images.  Click
“save.”
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Subsetting: Change Detection Images

The Landsat satellites have been acquiring imagery of the Earth since

1973.  It is the longest record of a MultiSpectral high-resolution global

data.  Many data users find observing change over time one of the

most engaging uses for Landsat data.  For example, the GLOBE
Program has developed a new change detection protocol

(http://www.globe.gov/tctg/land_prot_changedetect.pdf?sectionId=21

3) that asks students around the world to document how the Earth is

changing.

Subsetting: Change Detection Images Step 1: (This step

requires the most recent version of MultiSpec©.) Download all

the bands of data for each scene to be used from the Global Land
Cover Facility download website. Be sure that the scenes you have

selected to be compared have identical path and row numbers.

Subsetting: Change Detection Images Step 2: If you plan to use

the thermal data, band 61, prepare the data using the procedure
outlined in Preparing the Thermal Band (above).

Subsetting: Change Detection Images Step 3: Link all the bands

you wish to use from one scene. Subset a study area from this same
scene, following directions under Subsetting Single Images, above.

Subsetting: Change Detection Images Step 4: Open the B1 or

blue band of the second scene and link the bands using the procedure
outlined in Linking Bands of Data (above).

Subsetting: Change Detection Images Step 5: Once all of the

bands are linked in the second scene, pull down the “Window” menu
and select “Show Coordinate View.”

Subsetting: Change Detection Images Step 6: Open the subsetted

image and select “Show Coordinate View.”
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Subsetting: Change Detection Images Step 7: In each image

select the “Coordinate” pull down menu and select the Lat-Lon

(Decimal) option.

Subsetting: Change Detection Images Step 8: Bring the subsetted
image to the front.

Subsetting: Change Detection Images Step 9: Pull down the  Edit

menu and Select All to select the entire image. Go back to the Edit pull
down menu, and select “Selection Rectangle.” When the window pops

up, click on the “Units” pull down menu, and change the units to

Latitude-Longitude. Check the box labeled “apply to all image

windows.”
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Follow the next steps for each image:

Subsetting: Change Detection Images Step 10: Pull down

the“Processor” menu, and highlight “Reformat image.”  A box will

appear; select “Change Image File Format.”

Subsetting: Change Detection Images Step 11: In the “Image File

Format Change Options” window find the “header” pull down menu,

and select GeoTIFF format.  (This option will only work if the Landsat

data is originally a GeoTIFF.  The GeoTIFF file format is ideal because
the file header contains all of the geographic information.)

Subsetting: Change Detection Images Step 12: Click “OK”.  When

the next box pops up, don’t change the start and end lines and
columns, but make sure the intervals are set at one.  Click OK.

Subsetting: Change Detection Images Step 13: The next box to

pop up is for you to name and save the multi-channeled image.  Give

the image a name such as “name of county” and the date the image
was taken.   End the file name with the file extension “.tif”  An

example would be “Seattle_06_23_01.tif”  Make sure you are saving

the image to the same file where you have all the previous images.

Click “save”.
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Subsetting: Change Detection Images Step 14: Repeat the steps

10 through 12 for the second image.

Once each image is created, you are ready to study how the area has

changed over time.  To help with this procedure you can use the

GLOBE Program’s Change Detection protocol

(http://www.globe.gov/tctg/land_prot_changedetect.pdf?sectionId=21
3) and tutorial

(http://www.globe.unh.edu/MultiSpec©/Change/Change.html),

NASA’s Grow Smarter web site (http://growsmart.gsfc.nasa.gov) or

the NASA Landsat Change Detection Website
(http://landsat.gsfc.nasa.gov/change/)
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HELPFUL TIPS
TOP

File size
• To determine the amount of storage capacity required by Landsat data, use

the following formula: multiple the number of lines by the number of columns

by the number of bands you are using. for example, the GLOBE program’s

Landsat scenes are 512 X 512 pixels, and include only the first 5 Landsat

bands of data.  (This format was selected partly so that the image file would

fit on a floppy disk.)  The GLOBE program’s Landsat file is 1.31 MB.(512 lines

x 512 columns x 5 bands = 1,310,720 bytes or 1.31 MB) The area a 512 X

512 pixel image covers is 15.36 Km by 15.36 Km.  Remember that each pixel

is 30 meters by 30 meters.

• The largest area that will fit on a floppy disc if you are using all 7 bands of

data is 430 X 430 pixels

• The area a 450 X 450 pixel image covers is 13.50 Km by 13.50 Km. If you

want to make an image with a larger spatial extent be aware that these

images will test both the CPU speed and RAM memory of your computer.  A

laptop computer with 192 RAM and a CPU speed of 466 loads full Landsat

scenes very slowly and MultiSpec© has difficulty displaying these scenes at

full resolution.  A full Landsat scene has approximately 7,000 lines or rows by

8,000 columns of pixel data.


